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NEW QUESTION: 1

Which three statements are correct regarding the automation tools in Marketing Cloud?

Choose 3 answers

A. Automation Studio and Journey Builder allow users to define a wait activity based on duration.
B. Automation Studio and Journey Builder allow users to repeat an interaction indefinitely.

C. Journey Builder allows users to update a contact record in a journey or import data into a data
extension.

D. Journey Builder allows users to inject Contacts from a data extension which is updated by
Automation Studio.

E. Automation Studio and Journey Builder allow users to define the parameters of a send within
the tool.

Answer: (SHOW ANSWER)

NEW QUESTION: 2

A customer wants to automate the process of sending a series of welcome emails based on the
Subscriber's data. Emails should be sent weekly for up to five weeks. If a subscriber makes a
purchase, they should stop receiving welcome emails. A Boolean flag should be set in the data
extension ifthe subscriber makes it through the welcome series.

Which steps should be used to accomplish this in Journey Builder?

A. Define Goal, Send Email, Wait, Decision Split

B. Random Split, Send Email, Wait, Define Goal

C. Define Goal, Update Contact Data, SendEmail, Wait

D. Update Contact Data, Wait, Send Email, Join

Answer: C (LEAVE A REPLY)

NEW QUESTION: 3
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Northern Trail Outfitters wants to integrate Marketing Cloud with its existing point-of-sale system
in order in email purchase receipt to its customers. The point-of-sale data will need to be
transformed to be received by the Marketing Cloud triggered send API.

What extension product should be used to accomplish this integration?

A. MuleSoft Anypoint Platform

B. Data Studio

C. Data Connector

D. Datorama

Answer: A (LEAVE A REPLY)

NEW QUESTION: 4

Northern Trail Outfitters wants to build an abandoned cart journey which includes a Decision Split
that evaluates if a customer has made a purchase after they enter the journey. Customer data is
stored in a master data extension ans purchase data is stored in a second data extension.

Which two steps should they include to accomplish this journey?

A. Use Data Designer in Contact Builder to relate the two data extensions.

B. Configure activities within Automation Studio to update the purchase data.

C. Utilize Entry Data on a Decision Split within Journey Builder.

D. Create a Data Relationship in Email Studio to relate the two data extensions.

Answer: A,B (LEAVE A REPLY)

NEW QUESTION: 5

A customer has an eCommerce site and Imports data into three data extensions daily; 'Orders’,
'Order_Details' and 'Products'

the data extension contains the following information:

* Orders: Orderld, Customerld, OrderNumber, OrderDate, OrderTotal, GrandTotal
* Order_Details: Productld, Orderld, Qty, UnitPrice, ExtendedPrice, Discount

* Products: Productld, SKU, Name, Description, Cost, Price

What two actions should be taken in Data Designer?

A. Create a one-to-one relationship between Order Details and Products

B. Create a one-to-many relationship between Orders and Order_Details

C. Create a one-to-one relationship between the contact record and Order_Details
D. Create a one-to-one relationship between Orders and order_Details

Answer: A,C (LEAVE A REPLY)

NEW QUESTION: 6

A consultant needs to send an email to subscribers who have made a purchase. The data used
for the send exists on two data extensions - Subscribers and OrderTable, and the customer would
like to include key information from both tables, such as:

CustomerlD, FirstName, EmailAddress, OrderlID, OrderDate, ShippedDate.

Which SQL statement should the consultant use?
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A. SELECT CustomerID, FirstName, EmailAddress, OrderlD, OrderDate, ShippedDate FROM
Subscribers INNER JOIN OrderTable ON Customer|D=CustomerID

B. SELECT * FROM Subscribers WHERE CustomerlID, FirstName, EmailAddress, OrderlD,
OrderDate, ShippedDate - JOIN OrderTable On CustomerlD=CustomerID

C. SELECT T1.CustomerlID, T1.FirstName, T1.EmailAddress, T2.0OrderID, T2.OrderDate,
T2.ShippedDate FROM Subscribers OUTER JOIN OrderTable ON
Subscribers.CustomerlD=0rderTable.CustomerID

D. SELECT T1.CustomerlID, T1.FirstName, T1..EmailAddress, T2.0OrderID, T2.OrderDate,
T2.ShippedDate FROM Subscribers T1 INNER JOIN OrderTable T2 ON
T1.CustomerlD=T2.CustomerID

Answer: D (LEAVE A REPLY)

NEW QUESTION: 7

As part of their brand guidelines, ABC Company uses a custom brand font for all print marketing
materials.

ABC Company wants to use their custom brand font in email as well.

What is the recommended best practice for font usage in email?

A. Edit an emails HTML to list the custom brand font in the style tags font-family property.

B. Build an email using multiple images, with all text saved in the brand font

C. Build an email as one image, with all text saved in the brand font.

D. Use a web-safe font for text that closely matches the brands custom font.

Answer: (SHOW ANSWER)

NEW QUESTION: 8

What is a correct statement about Send Log data?
Choose 3 answers

A. Can be included in measures and filters.

B. Can be accessed via Query activities.

C. Can be stored for a set period of time.

D. Can be added to a standard data view.

E. Can be incorporated into standard reports.
Answer: A,B,C (LEAVE A REPLY)

NEW QUESTION: 9

Northern Trail Outfitters received an email about reaching API limits within Salesforce and they
think this is caused by the integrated Marketing Cloud account.

Which two types of API calls are counted against the rolling 24-hour limit?

A. SOAP API Calls updating objects

B. CreateSalesforceObject() AMPscript

C. Bulk API

D. Login Calls
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Answer: A (LEAVE A REPLY)

NEW QUESTION: 10

What are data extension data retention policies?

A. Settings to control when a data extension creates a back-up of the data it contains.

B. Settings to prevent users from deleting a Data Extension created by another user.

C. Settings to "soft" delete all data in a Data Extension so there is no data loss.

D. Settings to define when a data extension or the data within the data extension is deleted.
Answer: (SHOW ANSWER)

There is no concept of soft delete or Archive.

NEW QUESTION: 11

What statements are correct regarding Attribute Groups? (Choose two.)
A. They link data extensions to contacts.

B. They link subscriber lists to contacts.

C. They link data extensions to other data extensions.

D. They link data extensions to subscriber lists.

Answer: (SHOW ANSWER)

Explanation/Reference:

NEW QUESTION: 12

Northern Trail Outfitters has been using Marketing Cloud for one of their brands for the last year
and wants to migrate another brand to their portfolio. The two brands have contrasting target
groups and identities so they need the emails and landing pages to have different styles that
refrain from mentioning the other brand in any way.

What should be recommended?

A. Create a new business unit for the new brand.

B. Request a second SAP for the existing business unit.

C. Request a Private Domain to be added to the existing business unit.

D. Implement a new SSL Certificate for the new brand.

Answer: B (LEAVE A REPLY)

NEW QUESTION: 13

Northern Trail Outfitters receives data from their point-of-sale system every night. The file is
placed on their Enhanced FTP, but there is not a consistent time or naming convention for the file.
In which two ways should they set up their automation to import the data from the file on a nightly
bais? (Choose 2 answers)

A. %%BASEFILENAME_FROM_TRIGGER%%

B. File Drop Starting Source

C. Scheduled Starting Source

D. %%BASEFILENAME_FROM_FILEDROP%%


https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html
https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html
https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html
https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html

Answer: B,D (LEAVE A REPLY)

NEW QUESTION: 14

Northern Trail Outfitters (NTO) wants to use Marketing Cloud to solicit customer service
feedback. If a customer indicates they are unhappy with the service they have received, NTO
wants a new case to be created in Service Cloud. NTO is unsure of what is possible within
Marketing Cloud but would like to use as much native functionality as possible.

What approach would a consultant recommend?

A. Use an AppExchange package to create a customized API integration between Marketing
Cloud and Service Cloud.

B. Use Automation Studio to capture positive or negative responses, and a Case Activity to
create a new case in Service Cloud.

C. Use an Engagement Split to capture positive responses, and a Case Activity to create a new
case in Service Cloud.

D. Use an Engagement Split to capture positive or negative responses, and a Custom Activity to
create a new case in Service Cloud.

Answer: (SHOW ANSWER)

NEW QUESTION: 15

A subscriber asked to be removed from a customer's email list multiple times by replying directly
to the customer's marketing message, but continues to receive emails.

Which steps will solve how replies are managed by the application? (Choose three.)

A. Confirm that the subscribers request contained one of the standard terms that qualify for
automatic unsubscribe.

B. Confirm that the RMM setting Unsubscribe Manual Requests is set to YES.

C. Confirm that an email address was provided as the Routing Address for Remaining Replies.
D. Confirm that Reply Mail Management (RMM) is configured for the customer's account.

E. Confirm that the RMM setting Delete auto-replies and out-of-office replies is set to NO.
Answer: B,C,D (LEAVE A REPLY)

NEW QUESTION: 16

Northern Trail Outfitters (NTO) uses Marketing Cloud to connect with its individual consumers,
retailers and wholesale buyers, and its corporate apparel customers. Marketing Cloud is currently
configured with data extensions containing Store, Order, Product, and Contact information. NTO
is in the process of implementing Data Designer and linking its data extensions.

How should consumers, retailers, and wholesale buyers be defined in Data Designer?

A. One-to-One Relationship

B. One-to-Many Relationship

C. Many-to-Many Relationship

D. Population

Answer: B (LEAVE A REPLY)
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NEW QUESTION: 17

Northern Trail Outfitters is using a Salesforce entry event in a Journey to send SMS to contacts
located in the United States. They notice new SMS contacts are not receiving messages, and the
mobile number in the Salesforce Entry Data Extension was missing the country code.

How could they resolve this issue?

A. Select 'US' as the sending country in SMS activity.

B. Configure the phone field in Salesforce as US locale.

C. Select 'Normalize Phone Number* in Journey settings.

D. Format the phone field in Salesforce as +[[phonenumber],

Answer: (SHOW ANSWER)

NEW QUESTION: 18

In which two ways can Contact Builder be used to affect data stored on a data extension?
(Choose two.)

A. Export data from a data extension to any SFTP location

B. Add a single record to a data extension

C. Reconcile contact data on multiple Contact IDs

D. Clear the data from a data extension

Answer: (SHOW ANSWER)

NEW QUESTION: 19

Northern Trail Outfitters (NTO) wants its monthly distributor newsletter email to appear to be sent
on behalf of the subscriber's account representative without segmenting the audience by sales
representative.

In which two ways could this distributor-specific sender profile be configured in a Marketing Cloud
account with Sender Authentication Package implemented?

Choose 2 answers

A. Match the external keys of the sender profile and data extension containing account
representative details.
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B. Use substitution strings to populate the From Name and From Email values in the sender
profile.

C. Pick "Choose from list," selecting the From Name and From Email values from the list of
account users.

D. Utilize AMPscript data extension lookups to dynamically populate the From Name and From
Email values.

Answer: (SHOW ANSWER)

NEW QUESTION: 20

Northern Trail Outfitters (NTO) wants to implement an abandon cart journey. The data for the
journey exists in three separate data extensions (DE).

* The first DE is populated by web analytics data, and does not contain a Subscriber Key or Email
Address value.

* A Customer Reference DE is updated daily and holds subscriber information.

* The third DE is populated by a file sent to the SFTP after five days If the customer has not
purchased the abandoned items.

* The third DE will be used in the journey for a decision split, and it does not contain a Subscriber
Key or Email Address.

* If the web analytics file is empty, NTO does not want the automation to finish running.

Which order of activities should be used to fulfill this requirement?

A. Scheduled Automation > Import File Activity > Data Extension Entry > Query Activity for file
one > Query Activity for file two

B. File Drop Automation > Import File Activity > Verification Activity > Query Activity for file one >
Query Activity for file two > Data Extension Entry

C. Scheduled Automation > Import File Activity > Verification Activity > Data Extension Entry >
Query Activity for file one > Query Activity for file two

D. File Drop Automation > Verification Activity > Query Activity for file one > Data Extension Entry
> Query Activity for file two

Answer: (SHOW ANSWER)

NEW QUESTION: 21

Northern Trail Outfitters (NTO) imports a file daily into Marketing Cloud of customers who have
bought a tent from their website that day. They want to set up a month-long welcome Journey
which sends emails specific to the purchase such as the type of tent, the available accessories for
the tent, and care of the tent at different points throughout the Journey. NTO also recognizes that
due to their competitive prices, they have had customers purchase more than one tent within a
month.

What type of data should be used in the Decision Splits in their Journey to make sure the choices
reflect the correct tent?

A. Journey Data

B. Contact Data
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C. Entry Data
D. Salesforce Data
Answer: A (LEAVE A REPLY)

NEW QUESTION: 22

A customer needs to link demographic information to its model in Contact Builder.
What type of relationship should be used?

A. One-to-One

B. Many-to-One

C. One-to-Many

D. Many-to-Many

Answer: (SHOW ANSWER)

NEW QUESTION: 23

Northern Trail Outfitters wants to send an email to one million contacts in Sales Cloud. The
criteria to segment contacts include using 10+ fields to segment.

Which process should the consultant utilize for a reliable send method?

A. Assign the one million contacts from the report to a Salesforce campaign, and use a Single
Step journey with Salesforce Campaign as an entry event

B. Query Synchronized Data Extensions using a query activity to a Salesforce Data Extension,
then send via Email Studio Send Flow

C. Send to a Salesforce Report from Marketing Cloud using Email Studio Send Flow

D. Import Salesforce Report through an import activity to a Salesforce Data Extension, then send
to data extension using Email Studio email send

Answer: D (LEAVE A REPLY)

NEW QUESTION: 24

Northern Trail Outfitters recently purchasedMarketing Cloud to start running cross-channel
campaigns. They are looking for guidance on which value to use as the subscriber key.
Which two options should the consultant recommend? (Choose 2 answers)

A.CRMID

B. LoyaltyProgram Number

C. Email

D. Mobile Device ID

Answer: (SHOW ANSWER)

NEW QUESTION: 25

Northern Trail Outfitters maintains their primary customer identity in their ERP system but
managers their customer service via Service Cloud. Customer data is updated in real-time based
on changes in the ERP, and the ERP customer ID serves as the Customer Key. They want to
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leverage Synchronized Data Extensions to import data about cases from Service Cloud every 15
minutes.

What consideration should be made before implementing this solution?

A. They will have to migrate to use Service Cloud IDs, such as the Contact ID, as the contact key
instead of ERP IDs.

B. The number of contacts added to the instance will be approximately twice as large by using
this integration pattern.

C. Moving to use the email address as the contact key would simplify the integration since it is
common to both systems.

D. Marketing Cloud will deduplicate customers based on their email address, meaning some
customers may be overwritten or not receive email.

Answer: C (LEAVE A REPLY)

NEW QUESTION: 26

A financial company wants to use Marketing Cloud to send late payment notices to accounts
whose payment due date lapsed the previous week. The company has shared the following:

* Payments.csv will arrive on the Enhanced SFTP each Monday at 1 a.m.

* Payments.csv will be encrypted.

* Payments.csv will contain data from the previous week.

* Late payment notices will be sent each Monday at noon.

* They need to receive a file containing customers who opened or clicked on the late payment
notice email within five days after send.

Which automation sequence represents a viable solution?

A. File Transfer > Import File > Filter > Wait > Send Email > Wait > SQL Query > Data Extract >
File Transfer

B. Import File > File Transfer > SQL Query > Wait > Send Email > Wait > SQL Query > Data
Extract > File Transfer

C. File Transfer > Import File > Filter > Wait > Send Email > SQL Query > Wait > Data Extract >
File Transfer

D. File Transfer > File Transfer > Import File > SQL Query > Wait > Send Email > SQL Query >
File Transfer

Answer: (SHOW ANSWER)

Explanation/Reference:

NEW QUESTION: 27

A customer manually imports records for sending. Each record contains a warehouse ID that is
shared between Marketing Cloud and a third-party system. The customer does not have
developer resources, but wants to include the warehouse ID in their tracking parameters so that
the third-party system can identify the subscriber.

What should a consultant recommend?

A. Use Guide Template Language created for each field in the data extension.
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B. Use personalization strings created by selecting the data extension.

C. Use AMPscript variables created from each field in the data extension.
D. Use Dynamic Content rules to select a content area for each subscriber.
Answer: D (LEAVE A REPLY)

NEW QUESTION: 28

Northern Trail Outfitters wants to capture dietary preferences for Contacts who have registered
for an upcoming launch event. They have created a data extension of Contacts who have
registered for the event and will send them an SMS message from MobileConnect asking them to
reply with their dietary preference.

When Contact reply to SMS message, the response message will be inserted into a data
extension using AMPscript.

Which two MobileConnect templates should be used to send the SMS message and capture the
responses?

A. Info Capture

B. Outbound

C. Test Response

D. Data Capture

Answer: (SHOW ANSWER)

NEW QUESTION: 29

For security reasons, Northern Trail Outfitters indicates they cannot store PII directly within their
Marketing Cloud account. They are considering implementing Tokenized Sending to pull PIl from
their data warehouse at send time. They indicate they send several large, time-sensitive emails
per year.

Which two considerations should be made about Tokenized Sending? (Choose 2 answers)

A. Personalization Strings still allow PII to be displayed within an email.

B. Service Level Agreements for email sends are unsupported with the inclusion of outside
servers.

C. Journey Builder Decision Splits provide a method to access data of Tokenized data natively.
D. Tokenized Sending should be combined with field-level data encryption for additional security.
Answer: A,B (LEAVE A REPLY)

NEW QUESTION: 30

Northern Trail Outfitters wants to capture dietary preferences for Contacts who have registered
for an upcoming launch event. They have created a data extension of Contacts who have
registered for the event and will send them an SMS message from MobileConnect asking them to
reply with their dietary preference. When Contact reply to SMS message, the response message
will be inserted into a data extension using AMPscript.

Which two MobileConnect templates should be used to send the SMS message and capture the
responses?
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A. Outbound

B. Info Capture

C. Data Capture

D. Text Response

Answer: B,D (LEAVE A REPLY)

NEW QUESTION: 31

Which two statements are correct about Send Logging? (Choose two.)

A. AMPscript can be used to pull data from Send Logs for use within emails.

B. Send Log data extensions are archived automatically based on retention settings.

C. A business unit can support up to three Send Logs.

D. SQL Query Activities can reference Send Logs in combination with system data views.
Answer: A,D (LEAVE A REPLY)

Send Log data extensions are never archived. Its deleted. A business unit can support only one

Send Log.

Valid Marketing-Cloud-Consultant Dumps shared by Actual4test.com for Helping Passing
Marketing-Cloud-Consultant Exam! Actual4test.com now offer the newest Marketing-Cloud-
Consultant exam dumps, the Actual4test.com Marketing-Cloud-Consultant exam questions
have been updated and answers have been corrected get the newest Actualdtest.com
Marketing-Cloud-Consultant dumps with Test Engine here:
https://www.actual4test.com/Marketing-Cloud-Consultant_examcollection.html (161 Q&As

Dumps, 30%OFF Special Discount: Freepdfdumps)

NEW QUESTION: 32

Which two statements about a database of record are correct? (Choose two.)

A. It is any database containing subscriber data.

B. It is a system in which a subscriber's status is maintained.

C. It is a centralized storage repository of data about objects or people.

D. It is any data structure in which multiple opt-in statuses can be stored for a subscriber.
Answer: B,C (LEAVE A REPLY)

NEW QUESTION: 33

A customer has an email newsletter to send out, but wants to deliver it with a targeted message
for customers within a specified age range. These data have been defined in attributes from a
sign-up landing page.

How should the customer individualize the email content?

A. Guide Template Language

B. Personalization Strings
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C. Dynamic Content Areas
D. Substitution Strings
Answer: (SHOW ANSWER)

NEW QUESTION: 34

A customer wants to automate a series of three emails as part of a Membership Renewal drip
campaign.

Email #1 will be sent one month prior to the member's renewal date.

Email #2 will be sent one week prior to the member's renewal date.

Email #3 will be sent on the member's renewal date.

A master audience is updated in real time via the API.

Which steps should be included in the customer's automation?

A. Import File Activity > three Send Activities to the master data extension.

B. Three Filter Activities > three Send Activities to the filtered audiences.

C. Three Send Activities to the master data extension.

D. Import File Activity > three Filter Activities > three Send Activities to the filtered audiences.
Answer: B (LEAVE A REPLY)

NEW QUESTION: 35

A customer executes a large number of sends via Marketing Cloud connect and is concerned
about API limits.

What should the consultant suggest to minimize the impact of Marketing Cloud Connect on daily
API limits?

(Choose two.)

A. Filter data

B. Turn off link details tracking

C. Turn off Individual Levels Tracking

D. Upgrade the MC account to ConnectedApp

Answer: C,D (LEAVE A REPLY)

NEW QUESTION: 36

A customer wants to send an email from Sales Cloud on behalf of the record owner.
How should the consultant meet this requirement?

Choose 2 answers

A. Use a custom Delivery Profile.

B. Use the Send From Record Owner option

C. Use a custom Send Classification.

D. Use the Organization-Wide Email address.

Answer: B,C (LEAVE A REPLY)

NEW QUESTION: 37


https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html
https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html
https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html
https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html

A customer wants to send a quarterly reengagement email to subscribers who have NOT opened
in the previous three months. The customer's plans are to:

*Use an existing Paste HTML email for the first send.

*Make only minor changes to the email creative for future sends.
*Send to the subscriber list.

*Deploy emails manually for now, but possibly automate in the future.
Which send method should be used?

A. Triggered Send

B. Send Flow Activity

C. Guided Send

D. Send Email Activity

Answer: B (LEAVE A REPLY)

NEW QUESTION: 38

Northern Trail Outfitters is using a triggered send to send customers their order confirmations.
Their commerce platform provides a JSON payload for order details.

What would they use to format the JSON within the email?

A. ParseJSON content block within Content Builder

B. SSJS platform function ParseJSON

C. TransformJSONQ AMPscript Function

D. BuildRowSetFromJSON() AMPscript Function

Answer: B (LEAVE A REPLY)

NEW QUESTION: 39

ABC Company needs to provide an IT staff member with access to Marketing Cloud. The staff
member needs to perform the following tasks:

* Maintain ABC Company's master suppression list.

* Configure data relationships.

* Create new subscriber attributes.

Which role should be assigned to the IT staff member?
A. Administrator

B. Data Manager

C. Analyst

D. Content Creator

Answer: B (LEAVE A REPLY)
Explanation/Reference:

NEW QUESTION: 40
A customer executes a large number of sends via Marketing Cloud Connect and is concerned
about API Limits.


https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html
https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html
https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html

What should the consultant suggest to minimise the impact of Marketing Cloud Connect on daily
API limits?

Choose 2

A. Upgrade the Marketing Cloud Account to ConnectedApp Authentification

B. Share Sales Cloud user licenses across Marketing Cloud users

C. Filter target audiences based on mapped profile attributes to reduce Bulk API calls

D. Use Data Stream to sync object data into a Data Extension in the Marketing Cloud

Answer: B,C (LEAVE A REPLY)

NEW QUESTION: 41

Northern Trail Outfitters is noticing a gradualdecline in the percentage of conversions per emails
sent in their digital marketing campaign. A new initiative is being adopted to reverse the trend.
What action should be taken to increase subscriber engagement? Choose 2 answers

A. Introduce more identity verification steps in check out process

B. Adopt a Cart Abandonment Email Campaign

C. Increase the use of dynamic content in emails

D. Increase volume ofemails to a wider audience

Answer: B,C (LEAVE A REPLY)

NEW QUESTION: 42

Which three statements are correct about Data Designer? Choose 3 answers

A. Data extensions can be linked to either the contact record or different data extensions,
including data extensions from other attributes groups.

B. Each attributes group can contain multiple data extensions, and each data extension can
include multiple attributes.

C. Each attributes group contains one data extension, and each data extension can include up to
50 attributes.

D. Data extensions should be linked directly to be contact record prior to being linked to different
data extensions.

E. Each attribute group can contain multiple lists, and each list can include multiple attributes.
Answer: (SHOW ANSWER)

NEW QUESTION: 43

Northern Trail Outfitters wants to include a 'view online' link in an email template to enable users
to view a web page version of the email.

Which personalization string should they include as the href attribute in the link?

A. %%view_online%%

B. %%view_as_webpage%%

C. %%view_email _url%%

D. %%vawp%%

Answer: B (LEAVE A REPLY)
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NEW QUESTION: 44

Northern Trail Outfitters (NTO) wants to implement a drip campaign to its highest-value outdoor
sports customers. NTO is including a deep product discount and wants to limit the audience to not
only its best customers, but also those customers most likely to respond.

Which three criteria should they use to create an audience for this campaign? (Choose three.)
A. Last Purchase Date

B. Proximity to Store

C. Conversion Rate

D. Lifetime Purchase Value

E. Ages in Household

Answer: A,C,D (LEAVE A REPLY)

NEW QUESTION: 45

A retail company's database of record resides at a 3rd-party company that also keeps track of
purchase history.

That database only updates once a day where new records can be created and merged. The
database uses an

"Email ID," which is a numeric field that represents both the business unit and email address. The
company now wants to be able to send real-time Welcome emails to people (newly registered
website users) who provide their email address in exchange for getting 10% off their first order,
and ensure this send is connected to "Email ID" in the database.

What key issue should be addressed? Choose 3 answers

A. Will the company need a custom preference center?

B. What will be used as the Subscriber Key?

C. Will new users have an "Email ID"?

D. How will Marketing Cloud and the database sync up?

E. What publication lists will be used?

Answer: B,C,D (LEAVE A REPLY)

NEW QUESTION: 46

Northern Trail Outfitters (NTO) wants to send out a communication to subscribers who have not
made a purchase the last six months. Customer are often opted-in to more than one messaging
channel. NTO would like to be able to communicate the same message across all channels.
Which flow would meet their needs?

A. Salesforce Entry Event > Query Activity > Automation Studio Activities

B. Query Activity > Data Extension Entry Source > Journey Activates

C. Import Activity > Decision > Journey Activities

D. Query Activity > APl Event > Automation Studio Activities

Answer: A (LEAVE A REPLY)
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NEW QUESTION: 47

Northern Trail Outfitters is using Journey Builder to send emails to loyalty members based on
recent activity. They anticipate that approximately half of their contacts will meet the entry criteria
for their journey.

How should they configure their entry source?

A. Use an Import Activity in Automation studio to filter the data as a Data Extension Entry Source.
B. Use a Query Activity in Automation Studio to create a segment before entering the journey.

C. Use a Data Extension Entry Source with an applied filter based on recent member activity.

D. Use a Contact Data Entry Source to segment the data configured in Attribute Groups in
Contact Builder.

Answer: (SHOW ANSWER)

NEW QUESTION: 48

Northern Trail Outfitters wants to import new contacts gathered from an external web form. The
entries are being collected at high frequency, potentially thousands per minutes. The data does
not need to be immediately ingested into Marketing Cloud as it is used in a daily scheduled
automation.

What Should be recommended?

A. Push each new record into Marketing Cloud vis Platform Event API on form submit.

B. Recreate this external web form inside Marketing Cloud.

C. Create this as a Journey Data Source via Journey Builder.

D. Perform a daily bulk export to SFTP for import via Automation.

Answer: (SHOW ANSWER)

NEW QUESTION: 49

A retail company wants to create journeys to target subscribers based on website behavior. They
have identified three separate groups: customers who searched for an item, abandoned a cart,
and made a purchase.

Which three questions should the consultant ask to design the data structure for this solution?
(Choose three.)

A. How are subscribers identified in your web analytics?
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B. How many messages should be included in each journey?

C. Should customers exit the journey when the goal is met?

D. How long after the behavior occurs will a subscriber need to enter a journey?
E. Should a single customer exist in multiple journeys at the same time?
Answer: A,D,E (LEAVE A REPLY)

NEW QUESTION: 50

Northern Trail Outfitters wants to send a weekly coupon campaign. They segment their audience
using data from several data extensions, which results in an audience size of approximately
200,000 subscribers. They want to send a reminder three days later at the subscribers' optimized
send time.

What solution should they use?

A. Automation Studio and Interaction Builder

B. Automation Studio and Journey Builder

C. Journey Builder

D. Automation Studio

Answer: (SHOW ANSWER)

NEW QUESTION: 51

A customer wants to display a subscriber's first name and the date of send in its monthly
newsletter, subscriber first name data is stored in data extension that won't be used in the send
definition.

Which option should be in this scenario?

A. AMPscript

B. Guide Template Language

C. SQL Query

D. Personalization strings

Answer: A (LEAVE A REPLY)

NEW QUESTION: 52

If I want to introduce a new line of footwear. | am excluding anyone who does not have shoe as
an attribute listed in their preference center. | plan to send the emails daily. After a short time, |
notice many people updating their preferences, and less emails are going out.

What is the issue causing less emails to go out? Select one.

A. Preference center is too strict

B. High Watermark if journey builder

C. Deliverability issues on account

D. Email frequency too high

Answer: B (LEAVE A REPLY)

NEW QUESTION: 53
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What action should be taken to increase subscriber engagement? (Choose two.)
A. Increase volume of emails to a wider audience.

B. Introduce more identity verification steps in check out process.

C. Adopt a Cart Abandonment Email Campaign.

D. Increase the use of dynamic content in emails.

Answer: C,D (LEAVE A REPLY)

NEW QUESTION: 54

During discovery a consultant confirmed:

*A master audience file containing contact information and data points will be used for
segmentation and imported nightly.

*The customer would like to implement a mechanism that consistently prevents sending
promotional emails to subscribers who work for their top three competitors.

What feature should a consultant include in the solution?

A. A global unsubscribe

B. An auto-suppression list

C. An auto-exclusion list

D. An exclusion list

Answer: D (LEAVE A REPLY)

NEW QUESTION: 55

A customer provides a file containing only new and updated subscriber records exported from its
marketing database.

* The file will be uploaded to the customer's Enhanced FTP automatically at 3AM daily.

* The customer requires that the import completes prior to 4AM.

* On average, the file will contain about 2 million rows of data each day.

Based on the customer's requirements and recommended best practices, how should the daily
file be imported?

A. Import the file to a data extension, using the '‘add and update' method.

B. Import the file to a list, using the 'update only' method.

C. Import the file to a list, using the 'add and update' method.

D. Import the file to a data extension, using the 'overwrite' method.

Answer: (SHOW ANSWER)

Explanation

Since Record count in more than 500 K so DE is used. New and Update is already specified in
question.

NEW QUESTION: 56

A retail company needs to create journeys that will target subscribers based onwebsite behavior.
They have identified 3 separate groups:

* Customers who searched for an item on their website.
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* Customers who abandoned a cart on their website.

* Customers who made a purchase on their website.

What should the consultant ask in orderto design the data structure for this solution? Choose 3
answers

A. How many messages should be included in each journey?

B. Should a single customer exist in multiple journeys at the same time?

C. Should customers exit the journey when the goal is met?

D. How long afterthe behavior occurs will a subscriber need to enter a journey?

E. How are subscribers identified in your web analytics?

Answer: B,D,E (LEAVE A REPLY)

NEW QUESTION: 57

ABC Company is setting up new hires on its instance of Marketing Cloud, which includes Email
Studio, Mobile Connect, and Social Studio. One of the hires needs to manage the operations of
all of the North American Business Units.

What two roles, custom or standard, could be assigned to this user to meet the requirement?
(Choose two.)

A. Marketing Cloud Channel Manager

B. Marketing Cloud Administrator

C. Marketing Cloud Email Marketing Manager

D. Marketing Cloud Regional or Local Administrator

Answer: A,B (LEAVE A REPLY)

Explanation

NEW QUESTION: 58

A Marketing Cloud user needs the email addresses of everyone who unsubscribed from a
particular email send. This user does NOT know SQL and does NOT have access to the
Enhanced FTP account.

What functionality should be used to retrieve the necessary data?

A. My Tracking

B. My Reports

C. Tracking Extract

D. Data Views

Answer: A (LEAVE A REPLY)

With my Tracking user can create a list, view in browser or download as an attachment with the
subscribers meeting the criteria

NEW QUESTION: 59

Northern Trail Outfitters wants to send an email to one million contacts in Sales Cloud. The
criteria to segment contacts include using 10+ fields to segment.

Which process should the consultant utilize for a reliable send method?
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A. Query Synchronized Data Extensions using a query activity to a Salesforce Data Extension,
then send via Email Studio Send Flow

B. Send to a Salesforce Report from Marketing Cloud using Email Studio Send Flow

C. Import Salesforce Report through an import activity to a Salesforce Data Extension, then send
to data extension using Email Studio email send

D. Assign the one million contacts from the report to a Salesforce campaign, and use a Single
Step journey with Salesforce Campaign as an entry event

Answer: B (LEAVE A REPLY)

NEW QUESTION: 60

ABC Company needs to provide an IT staff member with access to Marketing Cloud. The staff
member needs to perform the following tasks:

* Maintain ABC Company's master suppression list.

* Configure data relationships.

* Create new subscriber attributes.

Which role should be assigned to the IT staff member?
A. Administrator

B. Analyst

C. Data Manager

D. Content Creator

Answer: (SHOW ANSWER)

NEW QUESTION: 61

An online retail customer needs daily promotional email content to generate with minimal time
spent on creation. Their service contract includes building a custom dynamic template for this
purpose. The customer has communicated the following:

* The email content will highlight new inventory each day.

* A small team will run both their digital marketing operations and their email program.

* A user needs to build, test, and send a daily email in less than an hour.

* Images for the emails will be hosted on their website CMS.

Which question is relevant to identify strategies for designing the custom template for the
customer's daily promotional email? Choose 3 answers

A. What is the maximum file size of the images being used?

B. Will image URLs be available publicly?

C. How often will the layout of the content in a content area change?

D. What From Name will be used for these emails?

E. How often will email content be image-only with text overlaying images?

Answer: A,B,C (LEAVE A REPLY)
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NEW QUESTION: 62

A school corporation uses one contact per parent/child combination, updating the email address
based on who they are sending to. However, they would tike to pull data on which email
addresses receive which emails.

What functionality could be used to accomplish this?

A. Tracking Extract

B. Data Views

C. Send Log

D. Recent Email Send Report

Answer: B (LEAVE A REPLY)

NEW QUESTION: 63

A customer executes a large number of sends via Marketing Cloud connect and is concerned
about API limits. What should the consultant suggest to minimize the impact of Marketing Cloud
Connect on daily API limits? Choose Two

A. Turn off link details tracking

B. Filter data

C. Turn off Individual Level Tracking

D. Upgrade the MC account to ConnectedApp

Answer: (SHOW ANSWER)

NEW QUESTION: 64

Subscribers are collected on a customer's website whose subscription database of record is
Salesforce Marketing Cloud. The customer sends up to five emails per week based on subscriber
activity. The list is:

* Compiled in a database in the website Content Management System (CMS).

* Imported into Marketing Cloud nightly at 11 p.m.

What action should be taken if a third party is sending a message for the customer outside of
Marketing Cloud?

A. Unsubscribes should be synchronized between senders.

B. They will need to integrate with the Marketing Cloud SOAP API.

C. Engagement metrics will be passed into Marketing Cloud.
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D. The third-party send list should be pulled from the CMS.

Answer: B (LEAVE A REPLY)

The right answer is: They will need to integrate with the Marketing Cloud SOAP API.
Because this is what required to meet requirement "Unsubscribes should be synchronized
between senders" as well as "Engagement metrics will be passed into Marketing Cloud. "

NEW QUESTION: 65

Which data object should be used in conjunction with data extensions to create an opt- down
strategy for customers?

A. Profile attributes

B. Preference Lists

C. Preference attributes

D. Publication Lists

Answer: D (LEAVE A REPLY)

NEW QUESTION: 66

A real estate agency wants to send out a biweekly newsletter with the list of properties for all new
contacts added to a newsletter campaign in their Salesforce CRM. The journey consists of an
initial message with property listings and a follow up to those who have engaged with the content.
The rules around which properties are matched to the contact depend on agent assigned as a
contact owner, other agents who might have interacted with the contact, and contact's property
interest. The data model has a relationship between contact > person account > real estate agent
> property objects and all of those are available in CRM as well as synchronized to Marketing
Cloud.

What solution should be recommended for execution efficiency?

A. Use send from Salesforce CRM and Salesforce report to prepare personalization data.

B. Use Automation Studio to prepare personalization data and initiate journey.

C. Use Salesforce Data Event to initiate journey and scripting within emails for personalization
logic.

D. Use Automation Studio and Salesforce sends with campaign as an audience.

Answer: C (LEAVE A REPLY)

NEW QUESTION: 67

ABC Company is expanding its marketing efforts globally. Each country's marketing department
has its own business unit and is responsible for the creation and execution of all the marketing
campaigns. The Marketing Cloud Administrator is having trouble keeping up with the constant
influx of new users and would like to speed up the turnaround of granting new users access to the
Marketing Cloud.

In what two ways can this be accomplished? (Choose two.)

A. Assign Channel Managers the role of Marketing Cloud Analyst.

B. Assign Administration User permissions to the Channel Manager role.
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C. Assign Administration User permissions to individual users.
D. Assign Administration User permissions to each business unit.
Answer: B,D (LEAVE A REPLY)

NEW QUESTION: 68

As part of their brand guidelines, Northern Trail Outfitters (NTO) uses a custom brand font for all
print marketing materials. NTO wants to use their custom brand font in email as well.

What is the recommended best practice for font usage in email?

A. Edit an email's HTML to list the custom brand font in the style tag's font-family property.

B. Build an email as one image, with all text saved in the brand font.

C. Build an email using multiple images, with all text saved in the brand font.

D. Use a web-safe font for text that closely matches the brand's custom font.

Answer: (SHOW ANSWER)

NEW QUESTION: 69

A customer wants to automate a series of three emails as part of a Membership renewal drip
campaign.

* Email #1 will be sent one month prior to the member's renewal date

* Email #2 will be sent one week prior to the member's renewal date

* Email #3 will be sent on the member's renewal date

* A master audience is updated in real time via the API

Which steps should be included in the customer's automation?

A. Three filter activities -> Three send definitions to the filtered audiences

B. Three send definitions to the master data extension

C. Import activity -> Three send definitions to the master data extension

D. Import activity -> Three filter activities -> Three send definitions to the filtered audiences
Answer: A (LEAVE A REPLY)

NEW QUESTION: 70

A customer has several values that need to be used in the body of an email send:
* The data would be stored in a reference data extension, related on SubscriberKey.
* There may be one or more records for each subscriber.

* The audience is generally over 1 million subscribers.

* The content is time sensitive and should be sent as quickly as possible.

* The customer is not using "catch and release" sending.

* The reference data extension contains 25 columns.

Which method should be used?

A. AMPscript a single Lookup Function

B. AMPscript a single LookupOrderedRows Function

C. Server Side Javascript a single LookupOrderedRows Function

D. Dynamic content via the Dynamic Content Wizard
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Answer: B (LEAVE A REPLY)

NEW QUESTION: 71

Subscribers are collected on a customer's website whose subscription database of record is
Salesforce Marketing Cloud. The customer sends up to 5 emails per week based on subscriber
activity.

The list is:

* Compiled in a database in the website Content Management System (CMS).

* Imported into Marketing Cloud nightly at 11 p.m.

What action should be taken if a third party is sending a message for the customer outside of the
Marketing Cloud?

A. They will need to integrate with the Marketing Cloud SOAP API.

B. The third-party send list should be pulled from the CMS

C. Unsubscribes should be synchronized between senders.

D. Engagement metrics will be passed into Marketing Cloud.

Answer: (SHOW ANSWER)

NEW QUESTION: 72

A B2B customer notices they have a large number of subscribers marked as 'Held'. During
troubleshooting, they realize these were soft bounces from overwhelming the email servers of
many of the small companies with which they do business.

What step(s) should the customer take to move those subscribers back to 'Active'?

A. Use Contact Builder to mass update all 'Held' subscribers to 'Active' status.

B. Subscribers with a status of 'Held' should be re-enabled by contacting support.

C. Use a SQL query to change all subscribers with a status of 'Held' to 'Active' in All Subscribers.
D. Extract subscribers who have a status of 'Held', then import subscribers as 'Active’'.

Answer: D (LEAVE A REPLY)

NEW QUESTION: 73

Utilizing journey builder interactions for sending post-purchase communications to customers,
what contact entry mode fits?

A. Re-entry only after exit

B. No re-entry

C. Re-entry anytime

Answer: C (LEAVE A REPLY)

NEW QUESTION: 74

What are the similarities between Automation Studio and Journey Builder? (Choose three.)
A. Ability to define an email send.

B. The option to convert a qualified Lead to a Contact.

C. Fire an event from Automation Studio to Journey Builder.
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D. Have duration plus wait activity (look for answers that start with JB or AS).
Answer: (SHOW ANSWER)
Explanation/Reference:

NEW QUESTION: 75

A school corporation uses one contact per parent/child combination, updating the email address
based on who they are sending to. However, they would tike to pull data on which email
addresses receive which emails.

What functionality could be used to accomplish this?

A. Send Log

B. Data Views

C. Tracking Extract

D. Recent Email Send Report

Answer: A (LEAVE A REPLY)

NEW QUESTION: 76

Marketing Cloud user needs the email addresses of everyone who unsubscribed from a particular
email send.

This user does not know SQL and does not have access to the enhanced FTP account.

What functionality should be used to retrieve the necessary data?

A. My Tracking

B. My Reports

C. Data Views

D. Tracking Extract

Answer: (SHOW ANSWER)

Valid Marketing-Cloud-Consultant Dumps shared by Actual4test.com for Helping Passing
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NEW QUESTION: 77

ABC Company wants to automate the sending of shipping notices and a customer survey.
* Shipping notices will be sent once a day.

* The shipping file will be placed on the FTP some time after 4:00 p.m.

* The shipping data will be sorted in the Shipping Notice data extension.
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* A field in the data extension will contain the shipping date.

* The survey needs to be sent at 9:00 a.m., exactly 10 days after the customer's order ships.
Which workflow would most effectively enable ABC Company to do this?

A. Automation 1: Triggered Import File -> Filter -> Send Email -> Wait-> Filter -> Send Email

B. Automation 1: Scheduled to run daily at 7:00 PM Import File -> Filter -> Send Email -> Wait ->
Filter-> Send Email

C. Automation 1: Scheduled to run daily at 7:00 PM Automation 2: Scheduled to run daily at 9:00
AM Import File -> Filter -> Send Email -> Filter -> Send Email

D. Automation 1: Triggered Automation 2: Scheduled to run daily at 9:00 AM Import File -> Filter -
> Send Email -> Filter -> Send Email

Answer: (SHOW ANSWER)

If a question is related to automation and it mentions that a file will be available in the FTP always

at a specific time, your answer will be an option with a scheduled automation. Scheduled
automations are used when you know the time a file is pushed into FTP and it always runs at a
scheduled time. If a question is related to automation and there is an uncertainty when the file will
be pushed to FTP (ex; a day before last working day / if a date falls on a weekend, it will be
available on last Friday etc.), your answer will be an option with a Triggered Automation.
Triggered Automations are fired as soon as a file hits a specific location within FTP. Transfer
activity is involved when file is encrypted.

NEW QUESTION: 78

Northern Trail Outfitters sends emails for Password Resets from their web store when requested.
An SMS message should be deployed if the password reset email is not sent.

What processes should they utilize to ensure a timely delivery across email and SMS?

A. Triggered send definition, and use API response to determine and send API call to trigger an
SMS password reset

B. Multiple path journey with engagement split if password reset link clicked; if link not clicked,
then SMS Password Reset activity

C. Triggered send definition and use data extract Not Sent to a data extension then send SMS to
those failed sends

D. Transactional email send with the event notification service response to determine and trigger
an API call to an SMS message

Answer: D (LEAVE A REPLY)

NEW QUESTION: 79

A restaurant supply company captures email subscribers and leads through trade shows. They
hold a giveaway at each trade show to entice booth visitors to leave their contact information. In
the past, they have used a fishbowl to capture business cards, but need to update this to an
online sweepstakes entry vehicle displayed on a mounted tablet. Individuals should only be
allowed to enter once, and the winner will be selected randomly. All entrants receive a follow-up
email after the trade show asking them to confirm their opt-in for a monthly newsletter.
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Which two components are appropriate for this solution? (Choose two.)
A. Microsite with Web Collect to store entrants on a data extension.

B. Send Email Activity with a link to a subscription center.

C. Data Extension with double opt-in status defined.

D. Microsite with Smart Capture to store entrants on a data extension.
Answer: C,D (LEAVE A REPLY)

Web collect works with lists only, not data extensions.

NEW QUESTION: 80

Which three statements are correct about Data Designer? Choose 3 answers

A. Data extensions should be linked directly to be contact record prior to being linked to different
data extensions.

B. Each attributes group contains one data extension, and each data extension can include up to
50 attributes.

C. Each attribute group can contain multiple lists, and each list can include multiple attributes.

D. Data extensions can be linked to either the contact record or different data extensions,
including data extensions from other attributes groups.

E. Each attributes group can contain multiple data extensions, and each data extension can
include multiple attributes.

Answer: A,D,E (LEAVE A REPLY)

NEW QUESTION: 81

A customer is developing a new eCommerce section of their website and plans to leverage
transactional data in customer journeys.

Which two Marketing Cloud features will support this effort?

Choose 2 answers

A. Data Designer

B. Web Analytics Connector

C. Content Builder

D. Cloud Pages

Answer: B,C (LEAVE A REPLY)

NEW QUESTION: 82

A start-up meal delivery company recently launched in Canada to great success. Through their
website, customers can order individual meal kits for up to six people or subscribe to a weekly

meal kit delivery. As a new company, resources are limited, but demand is taxing their manual

processes for sending out ecommerce messages, such as order confirmation and subscription
confirmations.

What recommendation would best provide a scalable solution for the start-up?

A. An automated program to send daily transactional messages.

B. A triggered automation to send transactional messages.
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C. Triggered email sends to deliver transactional messages.

D. A manual email send for each transactional message.

Answer: C (LEAVE A REPLY)

Triggered Automation is for file drop when exact time is not known. Triggered email send is for

transactional message like order confirmation.

NEW QUESTION: 83

A customer wants to create a loyalty program by Identifying all subscribers who clicked on a link
within any email sent within the last six months.

What should be recommended?

A. Create and execute a Data Filter on the Click data view.

B. Create and execute a Tracking Extract.

C. Create and execute a Subscriber Engagement report.

D. Create and execute a SQL Query against the _Click data view.

Answer: (SHOW ANSWER)

NEW QUESTION: 84

What are the similarities between Automation Studio and Journey Builder?
A. Ability to define an email send

B. Have duration plus wait activity (look for answers that start with JB or AS)
C. Fire an event from Automation Studio to Journey Builder

Answer: A,B,C (LEAVE A REPLY)

NEW QUESTION: 85

Northern Trail Outfitters (NTO) plans to use Contact Builder to increase the scope of customer
information they can see in an effort to establish more effective 1:1 relationships. Northern Trail
Ouitfitters (NTO) has a separate instance of Sales Cloud serving as its current customer master
database.

What two actions should be taken when using Contact Builder? (Choose two.)

A. Create a data extension to incorporate the imported data from Dashboard.

B. Conduct manual imports of customer information from Sales Cloud.

C. Combine each individual's channel contact information under one record.

D. Use Marketing Cloud Connect to include data from Sales Cloud.

Answer: C,D (LEAVE A REPLY)

NEW QUESTION: 86

Tracking Alias question:

A. Can be found in some reports
B. Email Conversion Tracking
C. Same URL

D. Differentiate clicking email
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Answer: A,B,C,D (LEAVE A REPLY)

NEW QUESTION: 87

Northern Trail Outfitters wants a simple segmentation strategy for identifying subscribers for their
emails.

What solution should they use?

A. List model and Groups in Single Send Journeys

B. Data Extension Entry Source in Journey Builder with a filter

C. Attribute group in Contact Builder for segmentation

D. Relational data extensions with primary keys to match subscribers with their data

Answer: A (LEAVE A REPLY)

NEW QUESTION: 88

A customer wants to create a mobile app that requires users to log in or register before accessing
their dat

a. Their source of truth Is Sales Cloud which Is connected to Marketing Cloud. Users who log In
with existing credentials will have their device associated with their ContactKey. Users who
register with the mobile app will not have their devices associated with a ContactKey for up to 24
hours.

What consideration should a consultant provide to the customer?

A. Existing users will create additional Contacts in Marketing Cloud.

B. All mobile app users will create additional Contacts in Marketing Cloud.

C. Newly registered users will create additional Contacts in Marketing Cloud.

D. User device data is unavailable in Contact Builder for up to 48 hours.

Answer: C (LEAVE A REPLY)

NEW QUESTION: 89

A customer has a business requirement to exclude email addresses of certain contacts In their
loyalty program from the sends with several sender profiles. These contacts are dynamically
Identified with the help of the SQL query on a daily basis.

What solution should be recommended to automate exclusion of the Identified email addresses
from all future sends that use specific sender profiles'

A. Publication list

B. Exclusion data extension

C. Suppression list

D. Auto-suppression list

Answer: D (LEAVE A REPLY)

NEW QUESTION: 90
What are two possible outcomes when "Multipart MIME" is selectedduring the send process?
Choose 2 answers


https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html
https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html
https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html
https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html

A. Open and clickactivity are tracked in either version.

B. A custom text version will be sent with your HTML email.

C. The email will avoid detecting by various SPAM filters.

D. An auto-generated text version will be sent with your HTML email.
Answer: (SHOW ANSWER)

NEW QUESTION: 91

How do you add a contact in contact builder?
Choose 2

A. Import to DE

B. Import to All Subscribers List

C. Add manually to All Subscribers

D. Import to MyLists

Answer: A,D (LEAVE A REPLY)

Valid Marketing-Cloud-Consultant Dumps shared by Actual4test.com for Helping Passing
Marketing-Cloud-Consultant Exam! Actual4test.com now offer the newest Marketing-Cloud-
Consultant exam dumps, the Actual4test.com Marketing-Cloud-Consultant exam questions
have been updated and answers have been corrected get the newest Actualdtest.com
Marketing-Cloud-Consultant dumps with Test Engine here:

https://www.actual4test.com/Marketing-Cloud-Consultant_examcollection.html (161 Q&As
Dumps, 30%OFF Special Discount: Freepdfdumps)

NEW QUESTION: 92

Northern Trail Outfitters (NTO) experienced a 24-hour website outage beginning on a peak
shopping day, as a result, a number of logged-in customer's shopping sessions were disrupted.
When the site is back online, the retailer would like to encourage those shoppers to return the site
and continue their shopping.

What action should Northern Trail Outfitters (NTO) take?

A. Create and send an apology email which includes a discount for a future purchase to all
customers.

B. Do NOT send an email, as outage may have increased negative sentiment, resulting in
unsubscribes.

C. Import a file of logged-in customers into NTO's existing Abandoned Cart journey in Journey
Builder.

D. Create a user-initiated message to logged-in customers to send once the website is restored.
Answer: C (LEAVE A REPLY)

The answer can be 1 or 3. But the most appropriate solution is 1. Sending emails will not take the
user to a state where they left on the website. This requires developer involvement.
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NEW QUESTION: 93

What functionality is contained in Journey Builder that does not exist in Automation Studio?
A. Native execution of a Server-side JavaScript activity.

B. Flexibility to wait based on duration or a specific time.

C. The option to convert a qualified Lead to a Contact.

D. The ability to send an email to a Salesforce audience.

Answer: C (LEAVE A REPLY)

NEW QUESTION: 94

A customer is interested in designing a solution to ensure that subscribers only receive categories
of emails that they want to receive. The built-in subscription center will be used as part of the
solution.

Which feature should be utilized to make this happen?

A. Subscriber Keys

B. Profile Center

C. Send Logging

D. Publication Lists

Answer: (SHOW ANSWER)

NEW QUESTION: 95

Northern Trail Outfitters (NTO) uses Marketing Cloud to connect with its individual consumers,
retailers and wholesale buyers, and its corporate apparel customers. Marketing Cloud is currently
configured with data extensions containing Store, Order, Product, and Contact information. NTO
is in the process of implementing Data Designer and linking its data extensions.

How should consumers, retailers, and wholesale buyers be defined in Data Designer?

A. One-to-Many Relationship

B. Many-to-Many Relationship

C. Population

D. One-to-One Relationship

Answer: D (LEAVE A REPLY)

NEW QUESTION: 96

Northern Trail Outfitters (NTO) send emails from Content Builder and Journey Builder. When
subscribers reply to an email, NTO would like to send an auto-reply message using a pre-defined
HTML email that explains email replies are unmonitored and they should call NTO for any
inquiries.

How could these auto-reply messages be enabled?

A. Open Admin > Account Setting page in Email Studio and in the 'Auto Reply Email' section,
select

'Custom' and paste the HTML email code into the text area field.
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B. Create a Triggered Send and on the Reply Mail Management settings page, choose the
'‘Create Custom Response' option under 'Automated Response Email for Remaining Replies'
section, then select the Triggered Send email.

C. From the Reply Mail Management settings page, choose the 'Create Custom Response' option
under

'‘Automated Response Email for Remaining Replies' section and select the HTML email from the
'define email' link.

D. Create a Triggered Send and from a Sender Profile properties page, enable 'Custom Reply
Mail Management Settings', 'Use Auto Reply' and 'Reply using triggered send' options, then
select the Triggered Send email.

Answer: C (LEAVE A REPLY)

NEW QUESTION: 97

Northern Trail Outfitters wants to send special discount offer to engaged customers on their email
list.

What should be resolved prior to generating the audience?

A. When to send the email

B. Who the offer come from

C. How to determine engagement

D. What the offer will be

Answer: (SHOW ANSWER)

NEW QUESTION: 98

Northern Trail Outfitters has a file that drops intermittently to their SFTP account. Once this file
drops, they want to be able to have it immediately imported and then segmented to enter a
specific journey depending on the data inside the file.

Which two options would meet these requirements?

Choose 2 answers

A. Decision Split

B. SQL Query

C. Scheduled Automation

D. File Drop Automation

Answer: (SHOW ANSWER)

NEW QUESTION: 99

A customer wants to automate the process of sending a series of welcome emails based on the
Subscriber's dat

a. Emails should be sent weekly for up to five weeks. If a subscriber makes a purchase, they
should stop receiving welcome emails. A Boolean flag should be set in the data extension if the
subscriber makes it through the welcome series.

Which steps should be used to accomplish this in Journey Builder?
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A. Define Goal, Send Email, Wait, Decision Split

B. Random Split, Send Email, Wait, Define Goal

C. Update Contact Data, Wait, Send Email, Join

D. Define Goal, Update Contact Data, Send Email, Wait
Answer: D (LEAVE A REPLY)

NEW QUESTION: 100

During discovery, the customer outlines data requirements and the anticipated use of Marketing
Cloud with the following criteria:

* Customer data will be fully refreshed every night via Import activity from the customer's data
warehouse.

* Contact records will be augmented by relational data tables via Contact Builder.

* The customer data file will contain 5M records with 40+ attributes.

* One attribute will house HTML code, 1000 characters max, that will be used to populate
Account Access content areas in emails.

* A customer ID will be used as the unique identifier for each contact.

Which statement differentiates the use of data extensions over lists?

A. Data extensions are necessary for Contact Builder

B. Data extensions can store HTML codeas an attribute.

C. Data extensions allow for add/update Import activity.

D. Data extensions support Customer ID to be used as Subscriber Key.

Answer: A (LEAVE A REPLY)

NEW QUESTION: 101

A university plans to use Journey Builder to improve their 1:1 marketing to potential students,
current students, and alumni. The university currently has student data inSales Cloud. Other data,
such as course catalog, student demographics, and alumni information, is stored in external
systems.

Which two actions should be consultant recommend? Choose 2 answers

A. Create an Import Activity to import alumni data into Salesforce Report.

B. Use Synchronized Data Sources to obtain data from Sales Cloud.

C. Create list attribute to store student data from Sales Cloud.

D. Use Data Designer to link student and alumni data to the contact record.

Answer: B,D (LEAVE A REPLY)

NEW QUESTION: 102

A small restaurant franchise wants to implement Marketing Cloud to support their franchise
owners. The corporate office the advertising copy and subscriber list. The owners of franchised
stores add a customized local message to the marketing campaign.

What hierarchy should be recommended?

A. One parent business unit and a child business unit for each franchise owners


https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html
https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html
https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html

B. One parent business unit and a child business unit for franchise owners.
C. A parent business unit for each franchise owner

D. One business unit.

Answer: B (LEAVE A REPLY)

NEW QUESTION: 103

Northern Trail Outfitters' account is configured with Multi-Org to leverage two Salesforce CRM
accounts. In the Cloud Kicks business unit they want to disconnect the sandbox instance and
connect the production instance.

What additional configuration changes should they make?

A. Update query activities that reference the synchronized data extensions.

B. Remove existing user mappings, attribute mappings, and tracking subscriptions.

C. Rename and delete sandbox synchronized data extensions before connecting.

D. Configure Multi-Org settings to account for two production instances in Setup.

Answer: A (LEAVE A REPLY)

NEW QUESTION: 104

A customer provides a file containing only new and updated subscriber records exported from its
marketing database.

* The file will be uploaded to the customer's Enhanced FTP automatically at 3 a.m. daily.

* The customer requires that the import completes prior to 4 a.m.

* On average, the file will contain about two million rows of data each day.

Based on the customer's requirements and recommended best practices, how should the daily
file be imported?

A. Import the file into a list, using the 'update only' method.

B. Import the file into a list, using the 'add and update' method.

C. Import the file into a data extension, using the 'add and update' method.

D. Import the file into a data extension, using the 'overwrite' method.

Answer: C (LEAVE A REPLY)

Since Record count in more than 500 K so DE is used. New and Update is already specified in
question.

NEW QUESTION: 105

ABC Company wants to better understand subscriber behavior on their website upon arrival via
an email message. A local member of a Marketing Cloud user group mentioned the Web
Analytics Connector.

Which benefit is offered by installing the Web Analytics Connector in a Marketing Cloud account?
(Choose three.)

A. Pass web conversion data back into Marketing Cloud for use in email reporting.

B. Use the web analytics platform to trigger behavioral remarketing emails.

C. Recognize web traffic as originating from email instead of another channel.
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D. Track web activity from a click on an email URL back to a specific email campaign.
E. Match subscribers to web activity by passing Subscriber ID through email links.
Answer: C,D,E (LEAVE A REPLY)

NEW QUESTION: 106

An analytics team wants to get real-time updates on transactional email metrics, specifically Sent
and NotSent, to ensure they are fulfilling a legal object due to the nature of their messages.
What method should be suggested in this scenario?

A. Platform Events API

B. Data Retrieves on the Send Object

C. Event Notification Service

D. Data View Export with every send

Answer: C (LEAVE A REPLY)

Valid Marketing-Cloud-Consultant Dumps shared by Actual4test.com for Helping Passing
Marketing-Cloud-Consultant Exam! Actual4test.com now offer the newest Marketing-Cloud-
Consultant exam dumps, the Actual4test.com Marketing-Cloud-Consultant exam questions
have been updated and answers have been corrected get the newest Actualdtest.com
Marketing-Cloud-Consultant dumps with Test Engine here:
https://www.actual4test.com/Marketing-Cloud-Consultant_examcollection.html (161 Q&As

Dumps, 30%OFF Special Discount: Freepdfdumps)

NEW QUESTION: 107

ABC Company wants to set up a welcome journey that leverages customer data across three
data extensions:

Customers, Orders, and Products.

What is the best way to facilitate this within Contact Builder?

A. Create three distinct Attribute Groups that link Customers to Contacts, Orders to Customers,
and Products to Orders.

B. Create a single Attribute Group that links Customers to Contacts, Orders to Customers, and
Products to Orders.

C. Create three distinct Attribute Groups that link each data extension directly to Contacts.

D. Create a single Attribute Group that links Contacts to Customers, Orders to Products, and
Products to Customers.

Answer: B (LEAVE A REPLY)

Explanation/Reference:

NEW QUESTION: 108
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A customer needs to compare the engagement across three creative versions of an email, and
then send a follow-up email for those contacts who did NOT engage with any of the test versions.
Which sequence of activities in Journey Builder should accomplish this?

A. Random Split > Send email > Wait By Duration > Engagement Split > Join > Send email

B. Random Split > Send email > Join > Decision Split > Wait By Duration > Send email

C. Engagement Split > Send email > Wait By Duration > Random Split > Send email

D. Decision Split > Send email > Engagement Split > Send email

Answer: (SHOW ANSWER)

NEW QUESTION: 109

Northern Trail Outfitters is growing and acquiring other organizations, each with its own instance
of Sales Cloud. They are debating whether to upgrade Marketing Cloud Connect to Multi-Org.
What consideration could be provided to help with the decision?

A. Shared Salesforce Data Extensions will be enabled in up to 5 business units.

B. Once an account is upgraded to Multi-Org, it cannot be turned off.

C. Existing accounts cannot be upgraded to Multi-Org.

D. Custom profile and subscription centers will not be required.

Answer: B (LEAVE A REPLY)

NEW QUESTION: 110

A retail company does business in both the United States and Canada. They have a loyalty
program in which a customer can enroll. The company will provide a pre-segmented customer
file, per campaign, which has a

"Version" data field indicating the type of email the customer is to receive.

Which two questions should be asked to determine a data/segmentation strategy? (Choose two.)
A. Will customers be able to sign up for the loyalty program at the store?

B. Will "Version" values/meanings change, precluding reusable AMPscript?

C. Will a lookup table be needed for a dynamic From Name?

D. Is the purpose of these emails for acquisition or retention or transactional?

Answer: B,C (LEAVE A REPLY)

NEW QUESTION: 111

Northern Trail Outfitters has purchased a new Marketing Cloud account with two dedicated IP
addresses. One |IP address will be used for commercial sends, while the other will be reserved for
transactional messages.

Their customer base includes 1.5 million email addresses.

What should the consultant recommend?

A. Send to unengaged subscribers during the first two weeks of IP warming in order to give them
the opportunity to interact.

B. Suppress sends to AOL email addresses during the first two weeks of IP warming, then
resume sending to them during the third week.
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C. Split marketing campaigns over a number of days while migrating over smaller triggered
campaigns during the warming period.

D. Focus on warming the IP address for commercial sends, because it is not necessary to warm
an |IP address used only for transactional sends.

Answer: (SHOW ANSWER)

NEW QUESTION: 112

Northern Trail Outfitters (NTO) wants to implement a drip campaign to its highest-value outdoor
sports customers. NTO is including a deep product discount and wants to limit the audience to not
only its best customers, but also those customers most likely to respond.

Which three criteria should they use to create an audience for this campaign? Choose 3 answers
A. Lifetime Purchase Value

B. Last Purchase Date

C. Proximity to Store

D. Ages in Household

E. Conversion Rate

Answer: A,B,E (LEAVE A REPLY)

NEW QUESTION: 113

Northern Trail Outfitters has master data extension of 880,000 subscribers they want to randomly
split into 11 groups to test different messaging strategies.

How could this be accomplished?

A. Use Journey Builder with a random split activity.

B. Create a random data extension within Email Studio.

C. Use Automation Studio with a random split activity.

D. Create a random data extension within Contact Builder.

Answer: A (LEAVE A REPLY)

NEW QUESTION: 114

Which two statements are correct about Send Logging? Choose 2 answers

A. Send Log data extensions are archived automatically based on retention settings.

B. AMPscript can be used to pull data from Send Logs for use within emails.

C. A business unit can support up to three Send Logs.

D. SQL Query Activities can reference Send Logs in combination with system data views.
Answer: (SHOW ANSWER)

Explanation

Send Log data extensions are never archived. Its deleted. A business unit can support only one

Send Log.

NEW QUESTION: 115


https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html
https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html
https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html
https://www.freepdfdumps.com/Salesforce.Marketing-Cloud-Consultant.v2022-12-22.q147.html

Northern Trail Outfitters wants to set up an automation that imports a file and sends an email to
the contacts when the file is dropped on the SFTP. The name of the file will change, though it will
always start with thankyou_customers.

How would they set up the Import Activity to know the name of the file?

A. Set File Naming Pattern to %%AUTOMATED_FILENAME%%

B. Check the 'Use filename from Automation' checkbox

C. Set File Naming Pattern to %%BASEFILENAME_FROM_TRIGGER%%

D. Filename is automatically passed to Import Activity with File Drop Automations

Answer: (SHOW ANSWER)

NEW QUESTION: 116

A consultant needs to send an email to subscribers who have made a purchase. The data used
for the send exists on two data extensions--Subscribers and OrderTable, and the customer would
like to include key information from both tables, such as:

* CustomerlD

* FirstName

* EmailAddress

* OrderlD

* OrderDate

* ShippedDate

Which SQL statement should the consultant use?

A. SELECT * FROM Subscribers WHERE CustomerlD, FirstName, EmailAddress, OrderlD,
OrderDate, ShippedDate - JOIN OrderTable On CustomerID=CustomerlD

B. SELECT CustomerID, FirstName, EmailAddress, OrderlD, OrderDate, ShippedDate FROM
Subscribers INNER JOIN OrderTable ON CustomerlD=CustomerID

C. SELECT T1.CustomerlID, T1.FirstName, T1.EmailAddress, T2.0OrderlD, T2.OrderDate,
T2.ShippedDate FROM Subscribers T1 INNER JOIN OrderTable T2 ON
T1.CustomerID=T2.CustomerID

D. SELECT T1.CustomerlID, T1.FirstName, T1. EmailAddress, T2.0OrderlD, T2.0rderDate,
T2.ShippedDate FROM ' Subscribers OUTER JOIN OrderTable ON
Subscribers.CustomerlD=OrderTable.CustomerlD

Answer: C (LEAVE A REPLY)

NEW QUESTION: 117

A customer has an eCommerce site and imports data into three data extensions daily: Orders,
Order_Details, and Products. The data extensions contain the following information:

* Orders: OrderID, CustomerID, OrderNumber, OrderDate, OrderTotal, GrandTotal.

* Order_Details: ProductID, OrderlD, Qty, UnitPrice, ExtendedPrice, Discount.

* Products: ProductID, SKU, Name, Description, Cost, Price.

Which two actions should be taken in Data Designer? (Choose two.)

A. Create a one-to-one relationship between Order_Details and Products.
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B. Create a one-to-one relationship between the contact record and Order_Details.
C. Create a one-to-many relationship between Orders and Order_Details.

D. Create a one-to-one relationship between Orders and Order_Details.

Answer: A,C (LEAVE A REPLY)

NEW QUESTION: 118

A customer with limited technical resources has assistance in setting up a small email
deployment that the customer will maintain long term. The email will display men's shoes to
males in the audience and women's shoes to females in the audience. The sendable data
extension contains a field with a value of Male or Female.

Which method should a consultant recommend to ensure content is displayed properly within the
email?

A. AMPscript conditional against the Gender field

B. Dynamic Content Block

C. AMPscript LookupRows function

D. A/B Test Content type

Answer: B (LEAVE A REPLY)

NEW QUESTION: 119

Subscribers are collected on a customer's website whose subscription database of record is
Salesforce Marketing Cloud. The customer sends up to 5 emails per week based on subscriber
activity. The listis:

* Compiled in a database in the website Content Management System (CMS).

* Imported into Marketing Cloud nightly at 11 p.m.

What action should be taken if a third party is sending a message for the customer outside of the
Marketing Cloud?

A. Unsubscribes should be synchronized between senders.

B. They will need to integrate with the Marketing Cloud SOAP API.

C. Engagement metrics will be passed into Marketing Cloud.

D. The third-party send list should be pulled from the CMS.

Answer: (SHOW ANSWER)

The right answer is: They will need to integrate with the Marketing Cloud SOAP API.

Because this is what required to meet requirement "Unsubscribes should be synchronized
between senders" as well as "Engagement metrics will be passed into Marketing Cloud. "

NEW QUESTION: 120

Analyst of The Northern Trail Outfitters (NTO) marketing team needs to pull email metrics for an
upcoming quarterly company meeting. These metrics need to be reported per email campaign for
each of NTO's Business Units:

* Number of Sends

* Delivery Rate
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* Overall Bounce Rate

* Block Bounce Rate

*Open Rate

* Click Rate

* Complaint Rate

* Unsubscribe Rate

Which email report should NTO's Marketing Analyst pull from Marketing Cloud to get this
information?

A. Account Send Summary Report

B. Email Send Report

C. Email Performance Over Time Report
D. Campaign Email Tracking Report
Answer: D (LEAVE A REPLY)

NEW QUESTION: 121

Northern Trail Outfitters (NTO) is running a campaign for a brand new type of footwear inside
Journey Builder. The entry event: Prevents contacts from entering the journey if "shoes" is not
selected in their preferences.

Is based on a data extension which has Email Address as Primary Key.

A few weeks after launching the campaign, NTO's data analyst noticed a reduced email volume
and that some contacts inside the data extension updated their preferences after the launch of
the campaign. Even with

the entry event being triggered every day, those contacts are not receiving the welcome emails.
What could be the reason?

A. Their account has deliverability issues.

B. The entry event is triggered too often.

C. The contact fell below the High Water Mark.

D. The preference center is too precise.

Answer: C (LEAVE A REPLY)

Valid Marketing-Cloud-Consultant Dumps shared by Actual4test.com for Helping Passing
Marketing-Cloud-Consultant Exam! Actual4test.com now offer the newest Marketing-Cloud-
Consultant exam dumps, the Actual4test.com Marketing-Cloud-Consultant exam questions
have been updated and answers have been corrected get the newest Actualdtest.com
Marketing-Cloud-Consultant dumps with Test Engine here:
https://www.actual4test.com/Marketing-Cloud-Consultant_examcollection.html (161 Q&As

Dumps, 30%OFF Special Discount: Freepdfdumps)

NEW QUESTION: 122
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Which three statements about Send Log Data is correct?
A. Uses Measures, filters and programs

B. Can be stored for periods of time

C. Accessed using query

D. Added to a standard view

E. Can be viewed in standard report

Answer: (SHOW ANSWER)

NEW QUESTION: 123

A customer wants to send SMS messages as part of a Journey. They are concerned the
messages will deploy when subscribers are asleep. If a subscriber qualifies to receive an SMS
message as part of the journey between 1 a.m. and 6 a.m., the customer prefers the message to
not be sent.

What solution should a consultant recommend to meet the criteria?

A. Create a Journey Goal to exit subscribers from the Journey.

B. Run a SQL Query at 12:30 a.m. to create a suppression list.

C. Run an Import Definition at 12 a.m. to create a suppression list.

D. Create and enable a BLOCKOUT window In MobileConnect.

Answer: D (LEAVE A REPLY)

NEW QUESTION: 124

A customer needs to import data from an SFTP site. The customer wants to:
*Segment the contents of the file and then send emails.

*Transfer the file to the SFTP site at various times daily.

*Send to data extensions.

What sequence of automation activities should meet these requirements?
A. File Drop: Import File > Group Refresh > Send Email(s)

B. File Drop: Import File > SQL Query(s) > Send Email(s)

C. Scheduled: Import File > SQL Query(s) > Send Email(s)

D. Scheduled: Transfer File > Import File > SQL Query(s) > Send Email(s)
Answer: B (LEAVE A REPLY)

NEW QUESTION: 125

A company collects subscriptions on its websites. It does the following:

* Compiles that subscription list in a database in the website content Management System
(CMS).

* Posts this encrypted list to Marketing Cloud nightly at 11 p.m.

* Uses Marketing Cloud as the database of record.

* Sends up to five emails a week based on subscriber engagement with prior sends.

What automation sequence (excluding waits) should cover these requirements?

A. File Transfer > Import File > SQL Query > Send Email
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B. File Transfer > Data Extract > Filters > Send Email
C. File Transfer > SQL Query > Measures > Send Email
D. File Transfer > Import File > Measures > Send Email
Answer: A (LEAVE A REPLY)

NEW QUESTION: 126

A mobile contact is not receiving SMS messages sent via MobileConnect.

In which two ways could a consultant troubleshoot this issue? (Choose 2 answers)
A. Ensure the "opt-in" box is checked in the Mobile Connect Demographics table.
B. Check the contact opt-in status in All Subscribers.

C. Ensure the contact is subscribed to the correct keyword.

D. Check the contact is subscribed to the correct short or long code.

Answer: (SHOW ANSWER)

NEW QUESTION: 127

Which two statements are correct regarding Attribute Groups? (Choose two.)
A. They link subscriber lists to Contacts.

B. They link data extensions to Contacts.

C. They link data extensions to subscriber lists.

D. They link data extensions to other data extensions.

Answer: (SHOW ANSWER)

NEW QUESTION: 128

A retail company's database of record resides at a 3rd-party company that also keeps track of
purchase history.

That database only updates once a day where new records can be created and merged.

The database uses an "Email ID," which is a numeric field that represents both the business unit
and email address.

The company now wants to be able to send real-time Welcome emails to people (newly
registered website users) who provide their email address in exchange for getting 10% off their
first order, and ensure this send is connected to "Email ID" in the database.

What key issue should be addressed?

Choose 3 answers

A. How will Marketing Cloud and the database sync up?

B. What will be used as Subscriber Key?

C. Will the company need a custom preference center?

D. Will new users have an "Email ID"?

E. What publication lists will be used?

Answer: (SHOW ANSWER)

NEW QUESTION: 129
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Northern Trail Outfitters wants to import their Sales Cloud data into Marketing Cloud to leverage it
within Journey Builder. They have approximately 10 million customers and the data needs to be
available with a delay of no more than 30 minutes. Only customers where the consent checkbox
is selected in Sales Cloud should be imported, which represents approximately half of their
customer database

What should they implement?

A. Event Data from the Entry Event in Journey Builder

B. All Subscribers, since these are synchronized in real time

C. Import from Salesforce Report in Automation Studio

D. Synchronized Data Extensions with a filter

Answer: D (LEAVE A REPLY)

NEW QUESTION: 130

A customer has several values that need to be used in the body of an email send:

* The data would be stored in a reference data extension, related on SubscriberKey.

* There may be one or more records for each subscriber.

* The audience is generally over 1 million subscribers.

* The content is time sensitive and should be sent as quickly as possible.

* The customer is not using "Catch and release" sending.

* The reference data extension contains 25 columns.

What method should be used?

A. Dynamic content via the Dynamic Content Wizard.

B. AMPscript a single Lookup Function.

C. Server side JavaScript a single LookupOrderedRows Function.

D. AMPscript a single LookupOrderRows Function.

Answer: (SHOW ANSWER)

AMPscript can simply and efficiently handle inline personalization or simple IF ELSE statements.
Dynamic content is a set of predefined content elements that are displayed based on the value a
specific recipient bears in a specific field / attribute AMPscript Lookup rows fetch dynamically

content from a data extension based on the attribute that serves as the key value.

NEW QUESTION: 131

Northern Trail Outfitters wants to build an abandoned cart journey which includes a Decision Split
that evaluates if a customer has made a purchase after they enter the journey. Customer data is
stored in a master data extension ans purchase data is stored in a second data extension.

Which two steps should they include to accomplish this journey?

A. Utilize Entry Data on a Decision Split within Journey Builder.

B. Use Data Designer in Contact Builder to relate the two data extensions.

C. Configure activities within Automation Studio to update the purchase data.

D. Create a Data Relationship in Email Studio to relate the two data extensions.

Answer: A,B (LEAVE A REPLY)
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NEW QUESTION: 132

An online retailer would like to utilize Journey Builder interactions for sending post-purchase
communications to their customers.

What Contact Entry mode best fits this scenario?

A. Re-entry anytime

B. Re-entry after time

C. Re-entry only after existing

D. No re-entry

Answer: C (LEAVE A REPLY)

NEW QUESTION: 133

What are two ways Contact builder can alter the data in Data Extensions? (Choose two.)
A. Add Single Record

B. Clear Records

C. Extract Data

Answer: A,B (LEAVE A REPLY)

Explanation/Reference:

NEW QUESTION: 134

A retail company's database of record resides at a 3rd-party company that also keeps track of
purchase history. That database only updates once a day where new records can be created and
merged. The database uses an "Email ID," which is a numeric field that represents both the
business unit and email address. The company now wants to be able to send real-time Welcome
emails to people (newly registered website users) who provide their email address in exchange
for getting 10% off their first order, and ensure this send is connected to "Email ID" in the
database.

What key issue should be addressed? Choose 3 answers

A. What publication lists will be used?

B. Will new users have an "Email ID"?

C. What will be used as the Subscriber Key?

D. How will Marketing Cloud and the database sync up?

E. Will the company need a custom preference center?

Answer: (SHOW ANSWER)

NEW QUESTION: 135

Northern Trail Outfitters wants to send a welcome email to Contacts when a Contact record is
added as a campaign Member to a 'Loyalty Member' Campaign in Sales Cloud.

Which method should they use to send the email from Marketing Cloud?

A. Use Content Builder Send Flow to send the email to the Salesforce Campaign

B. Create a scheduled Automation with a Query Activity and a Send Email Activity
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C. Create a Journey with a Salesforce Campaign entry source and an Email Activity
D. Create a Journey with a Salesforce Data entry source and an Email Activity
Answer: C (LEAVE A REPLY)

NEW QUESTION: 136

A consultant wants to trigger an email whenever the Status field on the Lead Object changes to
Hot. Tracking data will need to be kept in the Sales Cloud.

Which three steps should the consultant use in the solution? (Choose three.)

A. Write an Apex Trigger on the Lead Object.

B. Enable Triggered Sends on the Lead Object in configuration.

C. Create the Triggered Send Definition in the Marketing Cloud.

D. Put a SOAP API in place via the Marketing Cloud API.

E. Create the Triggered Send Definition in the Sales Cloud.

Answer: A,B,C (LEAVE A REPLY)

Valid Marketing-Cloud-Consultant Dumps shared by Actual4test.com for Helping Passing
Marketing-Cloud-Consultant Exam! Actual4test.com now offer the newest Marketing-Cloud-
Consultant exam dumps, the Actual4test.com Marketing-Cloud-Consultant exam questions
have been updated and answers have been corrected get the newest Actualdtest.com
Marketing-Cloud-Consultant dumps with Test Engine here:

https://www.actual4test.com/Marketing-Cloud-Consultant_examcollection.html (161 Q&As
Dumps, 30%OFF Special Discount: Freepdfdumps)

NEW QUESTION: 137

A customer is starting a new children's fashion brand and wants to use a dedicated business unit
within their existing Enterprise 2.0 account. They anticipate many of their current Enterprise
contacts will subscribe to the children's brand, however, they want to separate subscriber opt-
outs of the Enterprise and children's brands.

The customer has minimal technical resources available for implementation and support.

What should a consultant recommend to meet these criteria?

A. Create attributes for each child business unit in "Profile Management" to record unsubscribes
B. Create a Business Unit Filter in 'All Subscribers' List to record unsubscribes

C. Select "Use separate 'Subscription Center' for this business unit" in Settings

D. Select "Subscribers will be unsubscribed from this business unity only" in Settings

Answer: D (LEAVE A REPLY)

NEW QUESTION: 138
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A consultant configured a triggered send definition in Sales Cloud for a customer using Marketing
Cloud Connect, The trigger is on a Custom Object called 'Shipments' and is enabled for Triggered
Sends in Setup.

Which two configuration requirements should be considered when troubleshooting? (Choose 2
answers)

A. There is a Master Detail Relationship from Contact to Shipment.

B. The Shipment object is on the Account Related List.

C. An Apex Trigger is created on the Shipment object.

D. The Shipment object requires a Lookup to Lead or Contact.

Answer: (SHOW ANSWER)

NEW QUESTION: 139

By which three standard methods could contacts be injected into a journey? Choose 3 answers
A. Sales/Service Cloud Event

B. Date-Based Event

C. CloudPages Form Submit Event

D. Predictive Intelligence Event

E. Mobile Response Event

Answer: (SHOW ANSWER)

NEW QUESTION: 140

A customer wants to automate the process of sending a series of welcome emails based on the
subscriber's data.

* Emails should be sent weekly for up to five weeks.

* If a subscriber makes a purchase, they should stop receiving welcome emails.

* A Boolean flag should be set in a data extension if the subscriber makes it through the welcome
series.

Which steps should be used to accomplish this in Journey Builder?

A. Update Contact Data, Wait, Send Email, Join.

B. Random Split, Send Email, Wait Define Goal.

C. Define Goal, Send Email, Wait, Decision Split.

D. Define Goal, Update Contact Data, Send Email, Wait.

Answer: (SHOW ANSWER)

NEW QUESTION: 141

What is the capability of the Import within Contact Builder? (Choose two.)

A. The target destination can be a DE, list, or All Contacts for Mobile Push or Connect.

B. The data source can be a local file, data filter, or file on any FTP.

C. Like the Import Wizard, the Contact Builder import definition can be executed without saving.
D. In order to use Map by Header Row, the fields in the DE and file must match exactly.
Answer: A,D (LEAVE A REPLY)
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A data source cannot be a data filter so answer A is not right.

NEW QUESTION: 142

n online retail customer needs daily promotional email content to generate with minimal time
spent on creation. Their service contract includes building a custom dynamic template for this
purpose. The customer has communicated the following:

* The email content will highlight new inventory each day.

* A small team will run both their digital marketing operations and their email program.

* A user needs to build, test, and send a daily email in less than an hour.

* Images for the emails will be hosted on their website CMS.

Which question is relevant to identify strategies for designing the custom template for the
customer's daily promotional email?

Choose 3 answers

A. How often will email content be image-only with text overlaying images?

B. How often will the layout of the content in a content area change?

C. What is the maximum file size of the images being used?

D. Will image URLs be available publicly?

E. What from name will be used for these emails?

Answer: B,C,D (LEAVE A REPLY)

NEW QUESTION: 143

The customer has the following requirements for storing engagement data in their data
warehouse:

* All email open and click activity must be pulled daily from MC

* Qutput files must meet the specific requirements for the data warehouse

* All the activity must be provided via FTP in one file.

Which automation workflow meets the customer requirements?

A. Query activity to pull data view information -> Extract activity of data extension -> Transfer
activity

B. Report activity that generates recent send summary report -> Report delivered directly to FTP
C. Extract activity of data view tables -> Query activity to create the required file -> Transfer
activity

D. Extract activity of tracking extracts that combines data into required file -> Transfer activity
Answer: (SHOW ANSWER)

NEW QUESTION: 144

Northern Trail Outfitters has master data extension of 880,000 subscribers they want to randomly
split into 11 groups to test different messaging strategies.

How could this be accomplished?

A. Create a random data extension within Email Studio.

B. Use Automation Studio with a random split activity.
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C. Use Journey Builder with a random split activity.
D. Create a random data extension within Contact Builder.
Answer: (SHOW ANSWER)

NEW QUESTION: 145

A customer wants to automate the send of a monthly promotional email. The customer will upload
an audience file to their account's Enhanced SFTP on a monthly basis on the 15th day of each
month, expecting the email to be deployed upon completion of the import activity. However, if the
15th of the month falls on a Saturday or Sunday, the customer will provide the file on the Friday
prior to the 15th and expect the promotional email to be sent on that Friday.

Which method should be used to automate their monthly promotional email?

A. Create a scheduled monthly automation which includes an Import File Activity and triggered
send.

B. Create a file drop automation which includes an Import File Activity and triggered send.

C. Create a file drop automation which includes an Import File Activity and Send Email Activity.
D. Create a scheduled daily automation which includes an Import File Activity and Send Email
Activity.

Answer: (SHOW ANSWER)

NEW QUESTION: 146

Northern Trail Outfitters (NTO) wants its monthly distributor newsletter email to appear to be sent
on behalf of the subscriber's account representative without segmenting the audience by sales
representative.

In which two ways could this distributor-specific sender profile be configured in the Marketing
Cloud account with Sender Authentication Package Implemented? (Choose two.)

A. Utilize AMPscript data extension lookups to dynamically populate the From Name and From
Email Values.

B. Use substitution strings to populate the From Name and From Email values in the sender
profile.

C. Pick "Choose from list," selecting the From Name and From Email Values from the list of
account users.

D. Match the external keys of the sender profile and data extension containing account
representative details.

Answer: A,B (LEAVE A REPLY)

Explanation/Reference:

NEW QUESTION: 147
An existing triggered send needs to be updated with new content. (Choose the BEST answer.)
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Answer: (SHOW ANSWER)
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